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Chapter 1.  
Safety and Site Requirements 

Chapter 1 describes safety conventions, safety procedures and site requirements necessary for proper 
operation of the nanoLC-1D plus and nanoLC-2D systems. Topics covered in this chapter include: 

 safety conventions (Section 1.1) 

 nanoLC safety practices (Section 1.2) 

 nanoLC Autosampler safety practices (Section 1.3) 

 site requirements (Section 1.4) 

1.1 Safety Conventions 
The following symbols are used in the manual: 

 

This label calls attention to a procedure, which, if not correctly executed, could result in injury or loss 
of life. Do not proceed beyond a ‘DANGER’ sign until the indicated conditions are fully understood 
and met. 

 

This label calls attention to a procedure, which, if not correctly executed, could result in personal 
injury. Do not proceed beyond a ‘WARNING’ sign until the indicated conditions are fully understood 
and met. 

 

This label calls attention to a procedure, which, if not correctly executed, could result in damage to the 
equipment. Do not proceed beyond a ‘CAUTION’ sign until the indicated conditions are fully 
understood and met. 

 

This label calls attention to important information. Read this information before continuing. 

1.2 nanoLC Safety Practices 
The following safety practices apply to the nanoLC system: 

Use of this equipment in a manner not approved by Exsigent Technologies may inhibit its safety 
protection. 

 

Perform periodic leak checks on all lines and fittings. 
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When replacing capillaries or fittings on the nanoLC system, exposure to solvents may occur. It is therefore
recommended that appropriate safety procedures be followed and personal protective equipment be used, 
according to the applicable material safety data sheets supplied by the solvent vendor. 

 

Do not allow flammable and/or toxic solvents to accumulate. Follow a regulated, approved waste disposal 
pro gram. Never dispose of flammable and/or toxic solvents into a municipal sewage system. 

1.3 nanoLC Autosampler Safety Practices 
The following safety practices apply to the optional nanoLC AS1 Autosampler system: 

 

Changes or modifications to this unit not expressly approved by Exsigent Technologies could void the 
instrument warranty and render the system inoperable. 

 
Use of this equipment in a manner not approved by Exsigent Technologies may inhibit its safety protection.

 

When you use the nanoLC Autosampler system, follow generally accepted procedures for quality control and 
methods development. 

 

When you use the nanoLC Autosampler system for chromatographic analyses and observe a change in the 
retention of a particular compound, the resolution between two compounds or peak shapes, immediately 
determine the reason for the changes. Do not rely on the analytical results until the cause of the change is 
determined. 

 

Only use fuses of the type and current rating specified. Do not use repaired fuses or by-pass the fuse 
holder. 

 
The supplied power cord must be used with a power outlet containing a protective ground contact. 

 

Do not change the external or internal grounding connections. Tampering with or disabling these connections 
could create a safety hazard and/or damage the nanoLC Autosampler system. The instrument, as shipped, 
is properly grounded in accordance with normal safety regulations. 

 

The combination of a nanoLC Autosampler system with a LC/MS system may require additional safety 
measures as described by the LC/MS system vendor. Detailed instructions for the safe grounding on the 
LC/MS system are outlined in the corresponding vendor’s operating/installation manual. 

Exsigent Technologies recommends using a grounding cable connected between the injection valve’s 
sample loop and an appropriate grounding point at the LC/MS source. This supplementary grounding will 
reinforce the safety configuration specified by the LC/MS system vendor. 
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Do not turn the instrument on if you suspect that it has incurred any kind of electrical damage. 

Instead, disconnect the power cord and contact an Exsigent Technologies representative for a product 
evaluation. Do not attempt to use the instrument until it has been inspected and approved for use. 

Electrical damage may have occurred if the system shows visible signs of damage, exposure to liquids or of 
having been transported under severe stress. 

Damage can also result if the instrument is stored for prolonged periods under extreme conditions (e.g. 
subjected to heat, water, etc.). 

 

Disconnect the power cord from its power supply before attempting any type of maintenance. 

Continue to exercise caution as capacitors inside the instrument may still be charged even after the 
instrument has been turned off. 

 

To avoid damaging electrical parts, do not disconnect an electrical assembly while power is applied to the 
nanoLC Autosampler system. Once the power is turned off, wait approximately 30seconds before 
disconnecting an assembly. 

 

This instrument contains a number of sensitive electronic components that may be damaged if exposed to 
excessive line voltage fluctuations and/or power surges. 

 

There are no operator-serviceable or replaceable parts inside the nanoLC Autosampler system or its power 
supply. If either unit is not functioning, contact an Eksigent Technologies representative. 

Never try to repair or replace any of the instrument’s components not described in the manual without the 
assistance of an Exsigent Technologies representative. 

 

To avoid injury during nanoLC Autosampler system operation, keep hands and loose objects away from the 
autosampler arm and syringe assembly. 

 
Do not operate the nanoLC Autosampler system without the safety shield properly installed. 

 

At all times, observe safe laboratory practices when handling solvents, changing tubing or operating the 
nanoLC Autosampler system in order to avoid injury. Know the physical and chemical properties of the 
solvents you use. See the solvent manufacturer’s Material Safety Data Sheets for any solvent being used. 

 

Use caution when working with any polymer tubing under pressure: 

• Always wear proper eye protection when near pressurized polymer tubing. 

• Do not use polymer tubing that has been severely stressed or kinked. 

• Do not use polymer tubing, in particular PEEK or DuPont Tefzel tubing, with tetrahydrofuran (THF), 
dimethylsulfoxide (DMSO), chlorinated organic solvents, concentrated mineral acids, such as nitric, 
phosphoric or sulfuric acids, or any related compounds. 

 

An on board lithium battery maintains the autosampler firmware when the instrument is turned off. Because 
it is hard-wired in place, it should only be replaced a factory authorized service engineer. 
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1.4 Site Requirements 
This section describes the requirements for power, air, space and environment for operation of your 
instrument. 

1.4.1 nanoLC Power Requirements 
The nanoLC is powered by a 24 VDC external power supply. Only the universal AC/DC adapter and 
power cord supplied with the instrument should be used. 

The external adapter permits operation from any line voltage between 100–240 VAC, 47–63 Hz and 
4A. 

1.4.2 nanoLC Autosampler Power Requirements 
Line voltage: 

 115 VAC; + 15/-20 %; 50 Hz/60 Hz; 250 VA 

 230 VAC; + 15/-20 %; 50 Hz/60 Hz; 250 VA 

Fuses: 

 For 115 VAC; two 5.0 AT-fuses 

 (¼” x 1¼”, UL/CSA) 

 For 230 VAC; two 2.5 AT-fuses 

 (5 x 20 mm, IEC 127) 

 All fuses UL-listed and CSA-certified 

1.4.3 Air Supply Requirements 
Operation of the instrument requires connection to a source of 100 psi (6.9 bar) regulated clean, dry air 
or nitrogen. The instrument site should be within about 6 m (20 ft) of the air/nitrogen regulator. When 
using compressed air,  Exsigent Technologies strongly recommends an air supply having a dew point of 
less than 4.5 C (40 °F). When using dry nitrogen or compressed air, Exsigent Technologies strongly 
recommends the use of air filtration to 5 µm (e.g. for compressed gas supplied at less than 150 psi, a 
Wilkerson F18 filter) and regulation to a working pressure of 100 psi (e.g. for compressed gas supplied 
at less than 150 psi, a Wilkerson R18 regulator or a Wilkerson B18 combination regulator/filter). If 
hydrocarbons are suspected in the air supply (i.e. air supplied from an oiled compressor). Exsigent 
Technologies strongly recommends the regulator be followed with a coalescing filter suitable for 
particle removal to 0.01 µm (e.g. a Wilkerson M18 coalescing filter). 

 
Note: Always follow manufacturer’s specifications in selecting and operating gas filters and regulators.

 

 
Note: Always follow manufacturer’s specifications for connecting, mounting and orienting gas filters 
and regulators. 

 

 
Note: Always perform proper maintenance of traps, filters and coalescing filters per manufacturer’s 
specifications. Liquids collected in filters and coalescing filters must be drained before the liquid level 
exceeds the manufacturer’s specifications. 
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1.4.4 Bench Space Requirement 
The nanoLC system requires clear bench space of at least the following dimensions. 

 nanoLC-1D plusTM: 21” (53 cm) wide × 20” (51 cm) deep × 19” (48 cm) high (allowing excess 
space for cables). 

 nanoLC-2DTM: 21” (53 cm) wide × 24” (61 cm) deep × 19” (48 cm) high (allowing excess space 
for cables). 

With the nanoLC Autosampler the height requirement for both systems is 27”  
(69 cm). 

This bench space requirement does not accommodate the computer, keyboard, mouse and monitor. 

1.4.5 Environment Requirements 
The instrument is designed to operate in an environment with ambient temperatures between 20 and 
30 °C (68–86 °F) and non-condensing humidity. 
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Chapter 2.  
System Installation 

Chapter 2 describes the recommended procedure for unpacking and installing the nanoLC system. 
Topics covered in this chapter include: 

 nanoLC system overview (Section 2.1) 

 unpacking the nanoLC system (Section 2.2) 

 placement of the system (Section 2.3) 

 connecting to the air supply (Section 2.4) 

 connecting the PC (Section 2.5) 

 installing the nanoLC Autosampler (Section 2.6) 

 connecting the nanoLC to power (Section 2.7) 

 installing software and instrument settings (Section 2.8) 

 configuring the nanoLC system (Section 2.9) 

 configuring the nanoLC Autosampler (Section 2.10) 

2.1 nanoLC System Overview 
The nanoLC systems are designed for HPLC applications that employ direct pumping at flow rates of 
several hundred nL/min. The fully integrated system includes binary gradient pumps, an additional pump 
or second binary gradient pump system, temperature-controlled flow modules, and a column switching 
valve. The system is compatible with the nano LC Autosampler. This chapter introduces the hardware 
and software features of the nanoLC systems. 

2.2 Unpacking the nanoLC System 
step 1 Inspect the shipping cartons for damage or evidence of mishandling. If external damage is evident, 

notify the carrier before opening the cartons. 

step 2 Cut the tape and open the flaps on the top of the nanoLC system shipping box. Remove the outer 
shipping box. 

step 3 Open the inner shipping box and remove the foam packing material from the top of the nanoLC 
system. 

step 4 Carefully lift the nanoLC system out of the box. Grasp the sides of the instrument; do not use the 
protective bag to lift the instrument. A second person may be needed to help slide the carton and 
foam inserts off the instrument. 
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step 5 Place the instrument on a lab bench. 

step 6 Check the contents of the accessory kit against the contents checklist in Appendix A to confirm that 
all items are included. 

step 7 The checklist for parts included with the nanoLC Autosampler is included in the nanoLC 
Autosampler manual. 

step 8 Unpack the computer and monitor and verify that no parts are missing or damaged. 

2.3 Placement of the System 
Place the nanoLC system on a lab bench in a location with convenient access to power and a source of 
100 psi (6.9 bar) regulated clean, dry air or nitrogen. The front of the instrument should be accessible 
at all times. The sides and back of the instrument should be clear to accommodate mobile phase 
reservoir placement and attachment, and computer cable attachments 

2.4 Connecting to the Air Supply 
Operation of the instrument requires connection to a source of 100 psi (6.9 bar) regulated clean, dry air 
or nitrogen as described in the section on Site Requirements. 

 

Figure 2-1.  Rear Panel - Air Connection  

Required tools and materials: 

 Clean, dry source of air or nitrogen at 100 psi (6.9 bar) 

 In-line moisture trap with ¼” end-fittings 

 6 mm or ¼” air supply line (included) 

 Quick-connect adaptor to 6 mm or ¼” supply line (included) 

step 1 Connect the supplied air line to a source of 100 psi (6.9 bar) regulated clean, dry air or nitrogen 
using the supplied quick-connect adaptor.  Connect the other end of the air line to the air connection 
on the back of the nanoLC system (see Figure 2-1). 

step 2 Turn on the air source to the nanoLC system. 

step 3 Test for air leaks. Turn off air supply and repair any air leaks that are found. 
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2.5 Connecting the PC 
Required materials: 

 Computer, keyboard and mouse 

 nanoLC system serial cable (included) 

 

Figure 2-2.  Rear Panel — PC I/O Connector 

Connect one end of the RS-232 cable to an available COM port connector on the computer. COM1 is 
recommended as it is selected as the default in the software configuration. 

The other end of the cable should be connected to the 9-pin connector labeled PCI/O on the rear 
panel of the nanoLC system (see Figure 2-2). Tighten the retaining screws at both ends to secure the 
cable in place. 

2.6 Connecting the nanoLC to Power 
Required materials: 

 24 VDC power supply (included) 

Insert the supplied 24 VDC power supply’s plug into the connector located on the back of the 
instrument (Figure 2-3). Plug the line voltage cord into an appropriately grounded line voltage outlet.  
Turn the nanoLC on using power switch on the back of the unit. 

 

 

Figure 2-3.  Rear Panel — Power Connection 

24 VAC Power
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2.7 Installing Software and Instrument Settings 
Required materials: 

 CD with control software  

 disk with system settings 

step 1 Insert the CD into the CD drive and install the Control Software (see software manual for additional 
information on installation). 

step 2 After installing software, but before starting the software, insert the disk with the system settings 
(shipped with new instrument). 

step 3 Locate the file titled ‘EKsetting.reg’ in the Settings subfolder. 

step 4 Double click on the file ‘EKsettings.reg’ to install the instrument settings into the registry of the 
computer. A window will pop up asking you if you really want to write to the registry (Figure 2-4). 

 

Figure 2-4.  First Registry Prompt Window 

step 5 Click Yes.  A second window will popup indicating that you have successfully written to the registry 
(Figure 2-5). 

step 6 Click OK. 

step 7 The factory settings for your instrument should now be loaded into the registry. You should still 
configure the system (section 2.9) in case the COM port or other settings need to be adjusted from 
the factory defaults. 

 

Figure 2-5. Second Registry Prompt Window 
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2.8 Configuring the nanoLC System 
Launch the Control Software from your computer’s Programs menu or from the Control Software icon 
on the desktop. 

If you did not connect the serial cable to COM1, or the instrument power is not turned on, a COM Error 
dialog box (Figure 2-6) will appear: 

 

Figure 2-6.  Serial Port Communications Error 

 
Note: If the nanoLC system is connected to the PC’s COM1 port and the error message still appears, 
re-boot the PC and re-start the software. 

If the nanoLC is connected to a communications port other than COM 1, the instrument configuration 
will need to be changed.   

step 1 Launch the control software.  The COM error in Figure 2-8 will appear.  Click on ‘Cancel.’  A second 
window will appear (see Figure 2-7).  Click on ‘OK’ to enter the software in DEMO MODE. 

 

Figure 2-7.  Running the Software in Demo Mode 

step 2 Select System > Instrument Config… from the Control Software’s Acquisition Window to access 
the Instrument Configuration Window (see Figure 2-8). 

The Instrument Configuration Window (Figure 2-8) is used to indicate which components are 
installed. It also sets the communications protocol and configures the system to work with other 
connected devices. Several instrument performance parameters are also set in this window. 
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Figure 2-8.  Instrument Configuration Window 

step 3 Select the appropriate COM port for the nanoLC from the dropdown list. 

step 4 Exit from the Control software. 

step 5 Launch the control software. 

The Instrument Configuration Window (Figure 2-8) is used to indicate which components are 
installed. It also sets the communications protocol and configures the system to work with other 
connected devices. Several instrument performance parameters are also set in this window. 

Select System > Instrument Config… from the Control Software’s Acquisition Window to access the 
Instrument Configuration Window. 

Make sure that one of the following systems is selected in the Device field. 

 nanoLC-1D plus 

 nanoLC-2D 

The computer is configured at the factory to use COM1 to communicate with the nano LC system. If the 
serial cable is connected to a different serial port, change the setting in the on this page to indicate the 
correct COM port. 

In the Injection Valve field, select Eksigent Internal. 

If an auxiliary A/D input (such as a UV detector) is connected to the system, specify the voltage range 
the external device will provide under Aux A/D. 

In the Advanced Options box, type an acceptable idle time after which the system will be shut-down 
and then check the box. 

Select the appropriate signal input and output settings based on the requirements of the other 
instruments connected to the Eksigent nano LC system. 
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Flow Stabilization Limits specifies the degree of flow rate stability required before a gradient will 
begin. For most applications, a setting of 100 nL/min should be sufficient. However for high sensitivity 
applications, this parameter should be set closer to 20 nL/min. 

The Pressure Limits box allows for the specification of a maximum system pressure. If the column 
pressure exceeds this limit, the run will be automatically stopped and no further injections will take 
place. There is no loss of sample if the system shuts down. For most applications a value of 3500 psi is 
recommended. 

Click OK to go back to the Acquisition Window. 

2.9 Configuring the nanoLC Autosampler 
Click on the Run Manager button to bring up the Run Manager Window for configuring the 
autosampler (Figure 2-9). 

 

Figure 2-9.  Run Manager Window 

Select Devices > Autosampler Type > NanoLC-AS1 and the following message will appear: 

 

Figure 2-10.  Run Manager shutdown prompt  

Click Yes to close the program. 

Click on Run Manager again, and Select Devices > Autosampler Device Settings.  Set the COM port 
for the Autosampler  
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Figure 2-11.  Autosampler Device Settings  

 
The system is not yet configured for operation. You must first complete the instructions in System 
Initialization prior to system operation. 
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Chapter 3.  
System Initialization 

Chapter 3 describes procedures used to prepare a system for initial operation or for operation following 
an extended period of non-use. Topics covered in this chapter include: 

 hardware components and functions (Section 3.1) 

 loading mobile phases (Section 3.2) 

 preparing the nanoLC Autosampler (Section 3.3) 

 flushing the sample loop and sample needle (Section 3.4) 

 connecting the nanoLC to the nanoLC Autosampler (Section 3.5) 

 verifying the flow rate (Section 3.6) 

3.1 Hardware Components and Functions 
This section provides a general description of the key components of the nanoLC systems and their 
various functions. 

Mobile phase outlets are located on the right side of the nanoLC system. Each channel has one 
mobile phase outlet which can be connected to the autosampler and a 10-port column switching valve. 

The 10-port Column Switching Valve is used to switch between reverse phase traps that are con-
nected to the valve for rapid sample loading. Refer to Appendix D for different valve configurations. 

An Optional 6-port injection valve is available instead of the nano LC Autosampler for manual sample 
loading. Refer to Appendix D for valve configurations. 

3.2 Loading Mobile Phases 
The procedure for loading mobile phases will be described for a single binary gradient system for 
reverse phase chromatography. 

If you have a NanoLC-2D system, complete this procedure for both channels 1 and 2. It is suggested 
that you use mobile phase A described below in both reservoirs of channel 1 and use the suggested A 
and B mobile phases for the low flow gradient in channel 2. 

If you have a nanoLC-1D system, complete this procedure for channel 1 using the mobile phases 
described below. It is suggested that you use mobile phase A in the single reservoir for channel 2 for 
high flow sample loading. 
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Required tools and materials: 

 Mobile phase reservoirs (p/n 800-00105) 

 Clean, degassed HPLC-grade mobile phase A (water with 2% acetonitrile and 0.1% formic acid 
suggested). 

 Clean, degassed HPLC-grade mobile phase B (acetonitrile with 2% water and 0.1% formic acid 
suggested). 

 nanoLC priming tool (p/n 801-00003) 

 15 mL centrifuge tube 

step 1 Clean all 50 mL mobile phase reservoirs with appropriate solvents. 

step 2 Close the orange valve on the reservoir by turning it to the perpendicular position.  

step 3 Fill reservoir A with mobile phase A and reservoir B with mobile phase B.  

step 4 Install both reservoirs and open each valve by rotating to a vertical position. 

Purging and flushing the pumps are critical operations to get maximum performance from a new 
instrument. Purging rapidly replaces the solvent in the pumps while flushing replaces the solvent in 
the capillaries connecting the pumps to the sample injector. 

 

 

 

Figure 3-1.  Top Panel — Reservoirs for the NanoLC-2D System 

Mobile Phase 
Reservoir 1B 

Mobile Phase 
Reservoir 2A 

step 5 Select System > Mobile Phases from the main window of the control software to present the 
Mobile Phases dialog box (Figure 3-2). 
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step 6 Set the composition for mobile phase A: Enter the correct solvent composition for Mobile Phase A. 
the A mobile phase will generally be mostly water.   

step 7 Set the composition for mobile phase B: Enter the correct solvent composition for Mobile Phase B. 
the B mobile phase will generally be mostly acetonitrile. 

 

Figure 3-2.  Mobile Phases Window  

step 8 Click the More… button to present the purge and flush settings (Figure 3-3). 

 

Figure 3-3.  Mobile Phases Window — Advanced  

step 9 Purge the bubbles from each pump using the priming tool using the following steps: 

a. Under Purge Settings, select only one pump to purge, i.e. channel 1 A.  Set the number of 
purge cycles to 20. 

b. Click Purge Now.  The pump will begin to execute purge cycles.  While the pump is purging, 
insert the priming tool all the way into the pump and depress the check valve. 
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Hold down the priming
tool, and look for slight 
rise in the liquid in the 
bottle. 
 
When no more bubbles 
come out, remove the 
tubing and let the pump 
purge a few more times. 

 

Figure 3-3.  Priming Tool Usage 

c. After bubbles cease to come up into the bottle, allow the pump to continue purging for the rest 
of the 20 cycles.  

d. Repeat steps a-c for all the pumps separately to ensure each pump is adequately primed. 

step 10 Enter 10 for purge cycles, select Side A and de-select Side B.  

step 11 Click Purge Now to purge the A pump. 

step 12 Collect the purge output in a 15 mL graduated centrifuge tube. The pump should deliver a total of 
approximately 6 mL of solvent (600 µL per purge cycle × 10 cycles). 

step 13 Next de-select Side A and select Side B. 

step 14 Click the Purge Now button to purge the B pump. 

step 15 Collect the purge output for pump B and verify that the total volume is approximately 6 mL. 

step 16 Enter 100 for the µL Flush volume and select a flow rate appropriate for the maximum flow of the 
channel. For high flow channels, select 10 for the µL/min Total Flow rate. For low flow channels, 
select 6500 for the nL/min Total Flow rate. Ensure that the outlets of the pump are 
disconnected before proceeding. Flushing the system with a column connected could over-
pressure the system and create leaks. 

step 17 Click the Flush Now button. 

step 18 Repeat the above steps for the other channel. 

step 19 After the flush sequence ends, click OK to close the Mobile Phases window. 
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3.3 Preparing the nanoLC Autosampler 
The nanoLC Autosampler is the standard autosampler installed with nanoLC system. The autosampler 
should be pre-assembled and aligned by a qualified Eksigent Technologies service representative. 
Refer to the nanoLC Autosampler User Manual for a detailed description on its operation. 

Required tools and materials: 

 Clean HPLC-grade water 

 Clean HPLC-grade isopropanol 

 

Figure 3-4.  Eksigent nanoLC-1D+ Shown with Nano LC Autosampler  

step 1 Fill the wash bottle with a 20/80 mixture of isopropanol/water that has been degassed.  

step 2 Place the wash bottles on the wash station bracket and insert the Teflon tubing. 
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3.4 Flushing the Autosampler Syringe and Liquid Path 
step 1 On the front panel of the autosampler, select SYRINGE 

step 2 Select SYRINGE END and SYRINGE HOME repeatedly until the syringe is full of liquid with no 
bubbles.  Once no further bubbles are observed, click ESC and return to the main menu. 

step 3 Press WASH on the keypad to execute an initial wash.  Repeat twice for a dry liquid flow path. 

step 4 Press [menu] SERIAL to return the Autosampler to Serial Mode. 

step 5 Open the Run Manager and verify the AS-1 state is Idle.  This verifies the serial communication is 
active and the autosampler is connected. 

3.5 Connecting the nanoLC to the nanoLC Autosampler 
Required tools and materials: 

 Two orange 1/16” PEEK sleeves (p/n 910-00024) 

 Two 1/16” PEEK fittings and ferrules (p/n 920-00006 and 910-00023) 

 Green PEEK sleeve (p/n 910-00025) 

 Nut and ferrule for 0/025” fitting (p/n 920-00002 and 920-00003) 

 Two meters of 360mm OD / 50mm ID silica capillary (p/n 910-00002) 

 Capillary cutter (p/n 200-00096). 

 
Note: This section assumes connection of the nanoLC Autosampler using the high flow channel of the 
nanoLC instrument. If you are connecting with the low flow channel through the nanoLC Autosampler 
(e.g. for direct loading experiments) use 25 µm ID capillary for the connections to reduce delay 
volume. Two meters of 360mm OD / 25mm ID silica capillary (p/n 910-00008) are provided. 

step 1 Use the capillary cutter to ensure a clean cut on one end of the 50 µm ID capillary and connect it to 
the CH1 outlet of the nanoLC using the 0.025” green PEEK sleeve, ferrule, and nut. 

step 2 Cut the capillary at an appropriate length (approximately 40 cm) to connect from the CH1 outlet to 
the Pump connection on the injection valve of the nano LC Autosampler. Using an 1/ 16” orange 
PEEK sleeve and two-piece connector attach the capillary to the nanoLC Autosampler. Please make 
a clean cut at the end of the capillary and to fully seat the capillary and sleeve in the fitting. 

step 3 Connect the remaining piece of 50 µm ID capillary to the Column port of the nanoLC Autosampler 
injection valve using a second 1/16” orange PEEK sleeve and two-piece fitting. 

step 4 Cut the 50 µm capillary to a length appropriate to your experiment. This will most likely be a con-
nection to port 1 or 2 of the 10-port switching valve using one of the plumbing diagrams shown in 
Appendix D. 
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step 5 Open the Direct Control Window (Fig. 3-5) by clicking System > Direct Control from the Control 
software’s Acquisition Window. 

step 6 Set solvent A and B to 50/50 and Total flow rate to 20 µL/min. (for NanoLC-1D+, use 100%A). 

step 7 Click Start to flush the valve ports and capillary. Flush for 10 minutes. 

 

Figure 3-5.  Direct Control Window —  Flushing CH1 Autosampler Connection  

step 8 Stop the flow by clicking Stop. 

3.6 Verifying the Flow Rate 
Before operating the system it is suggested that you verify that the flow rate is properly calibrated. This 
is done by measuring the time it takes to move a liquid front through a graduated capillary of known 
volume. 

Required tools: 

 Flow calibration assembly (p/n 801-00002) for high flow rate channel (includes 20 µL pipettes) 

 Flow calibration assembly (p/n 910-00006) for low flow rate channel (includes 5 µL graduated 
pipettes) 

step 1 Re-initialize the pressure transducers (see section 4.5). 

step 2 Attach the appropriate flow calibration assembly to the outlet of channel 1 or 2. 

step 3 Select System > Direct Control from the Eksigent Control Software Acquisition Window.  

step 4 Set channel A to 100% and an appropriate flow rate for that channel (Figure 3-6). 

 5 µL/min for high flow channel 

 500 nL/min for low flow channel 
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step 5 Click the Start button and begin timing. With the high flow calibration assembly, the time it takes for 
the meniscus or an air bubble to transit from the black stripe to the end of the capillary should be 4 
minutes. With the low flow calibration assembly, the time it takes for the meniscus or an air bubble to 
transit across two segments of the capillary (2 µL) should be 4 minutes. Press Stop when the fluid 
front reaches the end of the pipette 

step 6 If the flow rate falls outside of the acceptable range (> ±5%) , re-calibrate the flow meters per the 
procedure found in Section 4.8 

step 7 Disconnect the calibration assembly and blow out the liquid inside the pipette using a pipette bulb or 
can of compressed air. 

 

Figure 3-6.  Direct Control Window — Flow Rate Check  

step 8 Set channel B to 100% and repeat steps 5 and 6 to verify the flow rate for pump B.  

step 9 Disconnect the calibration assembly. 
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Chapter 4.  
Routine Maintenance 

Chapter 4 describes the general procedures used to properly maintain the nanoLC system. Topics 
included in this chapter include: 

 recommended maintenance (Section 4.1) 

 disposing of waste (Section 4.2) 

 changing the sample loop (Section 4.3 

 replacing capillary connections (Section 4.4) 

 zeroing the pressure transducers (Section 4.5) 

 checking flow stability (Section 4.6) 

 autotuning flow controllers (Section 4.7) 

 calibrating flow meters (Section 4.8) 

 cleaning and inspecting the instrument (Section 4.9) 

 replacing internal instrument filters (Appendix E) 

4.1 Recommended Maintenance 
The nanoLC system is designed and built for long-term, robust use in an active laboratory environment. 
To ensure reliable performance, the following procedures should be performed at the specified interval. 

Table 4-1.  Recommended Maintenance 

Procedure Frequency Instructions 

Changing Mobile Phase As needed Section 3.2 

Zero pressure transducers Monthly Section 4.5 

Checking flow stability Quarterly Section 4.6 

Autotune flow controllers As needed Section 4.7 

Waste disposal As needed Section 4.2 

Replace interconnecting capillaries As needed Section 4.4 

Change sample loop As needed Section 4.3 

Calibrate flow meters Quarterly Section 4.8 

Clean and inspect system Quarterly Section 4.9 

Change internal instrument filters Annually Appendix E 
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4.2 Disposing of Waste 
The user will need to properly dispose of the contents of any effluent waste in an appropriate chemical 
waste container. For typical nanospray experiments, waste from the 10-port column switching valve due 
to high flow sample loading will be collected in a waste vial. 

The pump purge waste container located on the left side of the instrument will also need to be emptied 
periodically. Unscrew the thumbscrew holding the clamp around the waste bottle. Remove the bottle 
from the clamp and unscrew the cap from the bottle. Pour the contents into an appropriate chemical 
waste container. 

 

Always follow appropriate safety procedures when handling or disposing waste chemicals. See the solvent 
Material Safety Data Sheets for more information. 

4.3 Changing the Sample Loop 
Required tools and materials: 

 Laboratory wipes 

 Clean HPLC-grade methanol 

 1/4” open end wrench 

 Sample loop 

 Two 1/16” HPLC fittings (p/n 920-00006 and 910-00023) 

 
Note: This sample loop may be on the optional 6-port sample injection valve or on the nano LC 
Autosampler. 

step 1 Use the 1/4” wrench (or fingertight fittings) to remove the installed sample loop. 

step 2 Insert one end of the new sample loop through a 1/16” fitting and ferrule and into the injection valve 
port. Make sure the end of sample loop is flat and fully inserted into the valve port. Do not reuse 
fittings from other valves as the port depth can vary from valve to valve. 

step 3 Attach the other end of the sample loop to the opposite valve port. 

step 4 Open the Direct Control Window by clicking System > Direct Control from the Control software’s 
Acquisition Window. 

step 5 Set solvent A to 50, solvent B to 50 and Total flow rate to 6 µL/min (Figure 4-1).  

step 6 Click Start. 

step 7 Toggle the injection valve between the load and the inject position several times to flush out any 
loose particles. 

step 8 Look for any signs of leakage indicating a loose connection. Remake any connections that indicate a 
leak. 

step 9 Click Stop. 
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4.4 Replacing Capillary Connections 
Required tools and materials: 

 Laboratory wipes 

 Clean HPLC-grade methanol 

 1/4” Allen wrench 

 Transfer capillary 

 For the high flow channel, use 50 µm ID (p/n 910-00002) 

 For the low flow channel, use 25 µm ID (p/n 910-00008) 

 Microtight fitting 

 Green PEEK sleeve (p/n 910-00025) 

 Black microtight ferrule (p/n 920-00002) 

 Tan microtight nut (p/n 920-00003) 

 1/16” sleeved fitting 

 1/16” OD Orange PEEK sleeve (p/n 910-00024) 

 1/16” PEEK fitting nut (p/n 920-00006) 

 1/16” PEEK fitting ferrule (p/n 910-00023) 

step 1 Use the 1/4” Allen wrench or your fingers to remove the current fitting, ferrule, and sleeve. 

step 2 Remove the fitting and ferrule from the capillary and discard the old capillary. 

step 3 Cut the capillary to the appropriate length. Ensure a clean end cut and clean with methanol. 

step 4 Insert one end of a new capillary through the appropriate PEEK sleeve. 

step 5 Slide the end of the capillary and the PEEK sleeve through the compression fitting and ferrule. Make 
sure the sleeve extends through the ferrule. 

step 6 Slide the capillary, sleeve and fitting into the port until both bottom out. 

step 7 While lightly pressing the capillary and sleeve into the fitting with one hand, use the other hand or the 
1/4” wrench to tighten the fitting. 

step 8 Open the Direct Control window by clicking System > Direct Control from the Control software’s 
Acquisition Window (Figure 4-1). 
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Figure 4-1.  Direct Control Window 

step 9 Set solvent A to 50, solvent B to 50 and Total flow rate to an appropriate value for the channel you 
are connecting. 

step 10 Click the Start button and flush the capillary for 5 minutes. 

4.5 Zeroing the Pressure Transducers 
Before zeroing the pressure transducers, it is advisable to open the outlet fittings from the mixing tees 
on all channels. This will ensure there is no residual pressure on the outlet of the system. 

Zeroing the pressure transducers should be performed on a monthly basis. To initiate the 
pressure transducer zeroing procedure, start the Control software and access the diagnostics screen 
by selecting System > Hardware Diagnostics. 

 
It is very important that the instructions below are followed precisely. Attempting to zero the pressure 
transducers while there is still residual pressure on the system will lead to inaccurate flow rates. 
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Figure 4-2.  Hardware Diagnostics Window -Reinitialize Transducers  

step 1 In diagnostics, check the Re-Initialize Transducers box. 

step 2 Click Start Diagnostics. A message will appear (Fig. 4-3) warning that the procedure should only be 
performed if there is no residual pressure on the system. 

 

Figure 4-3.  Residual Pressure Warning 

step 3 Once the system indicates that it is at ambient pressure, click OK and a status window will indicate 
that auto-zero is in progress (Figure 4-4). 
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Figure 4-4.  Auto-zero Status Window 

step 4 When the auto-zeroing process is complete, exit the diagnostics window and return to the 
Acquisition Window. 

step 5 Repeat for both channels (if not conducted simultaneously). 

4.6 Checking Flow Stability 
The flow stability of the A and B channels can be determined in a similar fashion to the procedure used 
for zeroing pressure transducers as described in Section 4.5 by selecting the Check Flow Stability 
diagnostic test. Two screens will be observed during the running of the test (Figure 4-5). Initially the 
process requires the controllers to stabilize for 60 seconds. This is then followed by a 30 second 
examination of the control. 

Step 1       Step 2 

 

Figure 4-5. Checking Flow Stability Progression  

Repeat this for both channels. 

4.7 Autotuning Flow Controllers 
The flow controller autotune should be run on a monthly basis to optimize the performance of the 
system. 

 

To avoid the possibility of overpressure, disconnect the capillary at the mixing tee fitting prior to 
performing the autotune procedure. 

step 1 When the Autotune button is selected in the diagnostic window, the system’s response to changes 
in flow rate is monitored and adjustments are made to the controllers PID (proportional/integral/ 
derivative) loop. 

step 2 A prompt window alerts you that the autotune is about to begin (Figure 4-6). 
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Figure 4-6.  Autotune Prompt 

step 3 This is followed by status windows (Figure 4-7) which alert you that the system is preparing to Auto-
tune and then performing the autotune. 

These adjustments improve the system’s response time and flow rate accuracy. 

 

Figure 4-7.  Autotune Status Bars — Channel A 

step 4 Upon completion, close the diagnostics window and return to the main screen.  

step 5 Repeat for both channels (if not conducted simultaneously). 

 
Note: The slider below the Auto Tune Controllers button is used to change the pump time response. 
Moving the slider to the right will change the pump to respond faster (under-damped). Moving the 
slider to the left will change the pump to respond slower (over-damped). 

4.8 Calibrating the Flow Meters 
The flow meters should be calibrated quarterly or when the gradient separation performance seems to 
be drifting. Calibration of the flow meters consists of measuring the velocity of a liquid front in a tube of 
known diameter. Selecting the Calibrate Flow meters test will bring up a dialog box with step-by-step 
instructions for performing the test. 

Required tools: 

 flow calibration assembly (p/n 801-00002 or 801-00006) 

 
Note: If calibrating the low flow channel using the 801-00002 assembly, you can save time by con-
necting the pipette to the system and prefilling the pipette to approximately 5 µm before the first black 
line using either Direct Control or the Mobile Phases > Flush Now feature. 

step 1 Select System > Hardware Diagnostics from the Control software Acquisition Window. Selecting 
the Calibrate Flow meter test will bring up a dialog box with step-by-step instructions for performing 
the test. 
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Figure 4-8.  Flow Calibration Window 

step 2 Verify that mobile phases specified are correct. If incorrect, click Cancel to close the Flow meter 
Calibration Window. Make the necessary changes in the Mobile Phases Window, perform step 1 
again and then click Next. 

step 3 Attach the flow calibration assembly, with appropriate pipette to either the mixing tee or after the 
valve or column. Select the appropriate pipette size and flow rate for calibrating that channel (see 
table 4-2).20 µL/division in the pipette size to set the calibration flow rate to 5 µL/min for the high 
flow channel or 1 µL/division in the pipette size to set the calibration flow rate to 500 nL/min for the 
low flow channel. 

step 4 Click Next to start the flow in channel A. Enter the appropriate volume requested in step 3 of the 
Flow Calibration Window dialog (Fig. 4-8). Wait until the liquid front travels to the black line mark on 
the pipette and press Start to begin timing. For Channel 1, time how long it takes for the liquid front 
to travel 20 µL.  For Channel 2, time how long it takes for the liquid front to travel 2 µL. Press Stop 
when the fluid front reaches the end of the pipette, or the appropriate mark. Then click Next.    If 
necessary disconnect the calibration assembly and dry out the liquid inside the capillary.  

step 5 Repeat the measurement for calibration of the B channel flow meter. 

step 6 Verify that the instructions were followed exactly and that all values entered are correct and then click 
finish. 
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step 7 Use Table 4-2 to choose the proper calibration pipettes when calibrating the high flow and low flow 
channels of the nanoLC. 

Table 4-2.  Calibration Pipette Guide 

 High Flow Channel Low Flow Channel 

Calibrated Pipette Size 20 µL 1 µL/division (5µL total) 

Calibration Flow Rate 5 µL/min 500 nL/min 

Calibration Volume 20 µL/side 2 µL/side 

 

Figure 4-9.  Flow Calibration Pipettes 

4.9 Cleaning and Inspecting the Instrument 

 

Unplug the external power supply from the power source before cleaning and internal inspection. 

step 1 Clean the outside of the instrument by wiping down with a cloth slightly dampened with water and a 
small amount of liquid dish soap. 

step 2 Visually inspect the system fluidics and electronic connectors on a quarterly basis. Look for evidence 
of fluid leaks by checking all fluid connections. Also look for dried deposits that may indicate a slow 
leak. 

step 3 Identify and correct the source of any leaks if found. If a fluidic connection is broken, replace the 
fitting and re-flush the system. Inspect the new connection to ensure that no leaks are present. 
Dabbing a laboratory wipe around fluid connections is a good method to identify slow leaks. 
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Chapter 5.  
Quick-start Guide 

Chapter 5 offers a brief tutorial which should be useful in understanding the normal operation of the 
Eksigent nano LC. The procedures described in this chapter presume that the system has already been 
properly installed and initialized as described in chapters 2 and 3. Topics in this chapter include: 

 powering-up the system (Section 5.1) 

 purging and flushing with new solvents (Section 5.2) 

 equilibrating the system (Section 5.2) 

 creating an autosampler method (Section 5.3) 

 creating an LC method (Section 5.4) 

 creating a run table (Section 5.5) 

 starting a run (Section 5.6) 

 viewing the collected data file (Section 5.7) 

5.1 Powering-up the System 
If the system is not already on, turn on the nanoLC power switch mounted on the rear panel. The green 
LED on the front of the instrument should illuminate and the injection valve should initialize. 

If the autosampler is not already on, turn on the power switch on the nanoLC Autosampler. 

Turn on the computer, log-in to Windows and launch the Control Software by double clicking the 
software icon. 

After initialization, the Control software’s Acquisition Window of the Control software will be displayed 
(Figure 5-1). 

 
Note: On multichannel systems: Both the nanoLC-1D plus and the NanoLC-2D instrument have two 
channels of fluid control. They are denoted in this manual and in the software as channel numbers 1 
and 2. Throughout the software common windows are used to display or control these channels. To 
select the channel appropriate to that window (when available) simply click on the up or down arrows 
next to the channel number display in the upper right of the window. 
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Figure 5-1.  Acquisition Window 

5.2 Purging and Flushing with New Solvents 
If solvent has been sitting for more than 2 weeks, the solvent should be replaced with fresh solvent, 
then purged and flushed.  If the solvent is less than two weeks old, proceed to step 5.3. 

step 1 To discard old solvent in the reservoir bottles, one of two methods can be used: remove the bottle 
and pour out the old solvent, or purge the old solvent through to waste (Figure 5-2). 
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Figure 5.2- Emptying Solvent Reservoirs 

step 2 Pour new mobile phase into the bottle.  Purge the HPLC at least 10 times.  Depress the check valve 
while purging to dislodge bubbles in the pump head, as shown in figure 3.3.1. 

step 3 After the pump is thoroughly purged, flush.  Select System > Mobile Phases from the main control 
window.  Click More and flush the system 100uL on Channel 1 and Channel 2.  See section 3.2 for 
more information on flushing. 

5.3 Equilibrating the System 
The Control software’s Direct Control window (Figure 5-3) can be used to equilibrate the system 
following system power-up, a change of solvent or change of column. The injection valve can also be 
toggled between load and inject positions to flush the injection valve loop and interconnecting ports. 
Select System > Direct Control from the main Control software Acquisition Window. 

Close Loosen 

Grip 
stopcock- 
pull up Empty

Replace 
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Figure 5-3.  Direct Control Window 

step 1 Ensure that the Conserved Flow radio button is selected, set A (%) to 50 and B (%) to 50. This will 
be the mobile phase composition used for equilibration. 

step 2 Set the Total flow rate to 300 (nL/min). 

step 3 Click on Start to start the pumps and begin equilibration. 

step 4 Flush the switching valve (or an injection valve connected directly to the Eksigent nano LC 
instrument) by alternately clicking on the Load Position and Inject Position buttons in the Valve 
Manual Control area. To switch the valve in the nano LC Autosampler, use the Autosampler direct 
control in the run manager under Devices > Autosampler Device Settings > Direct Control Tab 
(Figure 5-5). 

 

Figure 5-5. Autosampler Configuration Window 

step 5 Allow the system to equilibrate for approximately 10 minutes. 
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5.4 Creating an Autosampler Method 
The parameters used for loading the sample into the injection valve and for rinsing the autosampler 
syringe and sample needle are stored in the autosampler method. This section will review an 
autosampler method appropriate for loading a trap with Channel 1, and running a gradient with Channel 
2. 

step 1 Place the sample vial containing the standard test mixture in vial position A1 of autosampler 48-vial 
tray. 

step 2 Click Run Manager in the Acquisition Window to open the Run Manager display (Figure 5-6). 

 

Figure 5-6.  Run Manager Window 

step 3 If you do not see a picture of the 48-vial tray in the Run Manager Window select the Devices > 
Autosampler Device Settings menu to set the tray type. You will need to restart the Run Manager 
after changing the tray type. 

step 4 If you do not see the columns shown in Figure 5-6, choose Edit > Choose Column… from the 
menu and select the appropriate columns for display. 

step 5 Click Autosampler Methods to bring up the Autosampler Method Editor Window (Figure 5-7).  
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Figure 5-7.  Autosampler Method Editor Window 

step 6 Select a method from the drop down method similar to the one above.  Highlight the name of the 
method, rename it, and click Save to create a new method. 

step 7 All Eksigent autosampler methods should contain the following steps in the same order.  The 
volumes can be modified but the general format should remain the same for a given method type.  In 
this example, a trap loading autosampler method is indicated: 
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Table 5.1.  Template for Micropickup Injection, Trap Loading Autosampler Method 

Step # Operation Volume Parameter Speed Height Description 

1 Output  1- Off   Ensure output 1 relay is in off state 

2 Output  2- Off   Ensure output 2 relay is in off state 

3 Valve   Injector Load   Place autosampler valve in load 
position 

4 Aspirate 19uL Reagent -1 1 0 Aspirate from Reagent 1 vial 
position 

5 Aspirate 1uL Sample 1 (1-5) Aspirate from Sample vial- use 
appropriate height for sample vial.  
1= closest to bottom, 5= 5 mm from 
bottom of vial. 

6 Aspirate 5uL Reagent -1 1 0 Aspirate from Reagent 1 vial 
position 

7 Output  1-On   Send Output 1 relay signal to LC 
Channel 1, signaling LC Channel 1 
to start the method 

8 Wait for input   1 - Low   Wait for an input signal (injection 
signal) from Channel 1 before 
continuing autosampler method. 

9 Valve   Injector Inject   Place autosampler valve in the inject 
position 

10 Wait for input   1- High   Wait for injection signal from LC 
Channel 1 to turn off, indicating the 
loop injection is complete. 

11 Valve   Injector Load   Place autosampler valve in the load 
position 

12 Output   2- On   Send Output 2 relay signal to LC 
Channel 2, signaling LC Channel 2 
to start the gradient method. 

13 Dispense  25uL Waste 5 0 Dispense aspirated volume to 
waste.  Total aspirate and dispense 
volumes must be equal. 

14 Needle wash  50uL    Perform 50uL needle wash 

15 End     Method end 

 

step 8 To modify method steps, click on the step and change the volume by typing over.  Modify the 
operation or parameter by clicking on the step and choosing a new value in the drop-down menu. 

step 9 Add new steps by clicking on the >> arrows to the left of the line.  Delete a step by clicking on the 
X. 

 
Note: for an autosampler configured with the standard 25uL syringe,  
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step 10 Change the Needle Wash volume to 100 µL. 

step 11 Needle Wash 100 µL. 

step 12 Type Autosampler Test in the Name field and click on Save next to the name to store the method. 

step 13 Click OK button to close the Autosampler Method Editor Window 

5.5 Creating an LC Method- Channel 1 
The conditions used for separating the sample are stored in the LC method. This section will create an 
analysis method called LC Test. LC methods are accessed for editing by clicking on LC Method Editor 
located in the Run Manager window. 

 
Note: For the NanoLC-2D. If ‘NanoLC-2D Parallel’ is chosen in the System > Instrument 
Configuration menu, then the LC Method editor appears as described in this section. If ‘NanoLC-2D 
is chosen, then the 2D Editor will appear. This editor allows for the easy and rapid con-figuration of 
multi-step, on-line 2D methods. Each multi-step experiment is saved as a single method file and can 
be programmed on a single line of the Run Table. Please see both the 2D section of the software 
manual as well as Appendix C for further description of the 2D valve configurations. 

step 1 Click LC Methods on the Run Manager window to display the Method Settings dialog box (Figure 
5-8). 

 

Figure 5-8.  LC Method Editor-Summary Tab 

nanoLC Operator’s Manual 611-00012 Revision A1 



Quick-start Guide..41 

step 2 To create a new method, type over the name of the method and click Save. 

step 3 If you wish, enter any column information appropriate for your experiment. This information is 
information-al and stored with the LC method file. 

step 4 Click on the Run Conditions tab of the LC Method Editor window to obtain the Run Conditions tab 
(Figure 5-9). 

 

Figure 5-9.  LC Method Editor — Run Conditions Tab 

step 5 Put a check mark in the Pre-Run Flush column check box and specify a time of 0.1 minutes to flush 
the column using 100% of the initial flow rate conditions. 

step 6 Select Standard: in the Sample Injection region. This will cause the injection valve to be placed in 
the inject position for the duration of the Channel 1 run.   

step 7 Leave the check mark box for Post-Run Flush column empty.  

step 8 Click on the Flow Table tab to set the gradient parameters.  

step 9 Enter the flow rate, time and percentages of A and B that are appropriate.  For a 2D system that has 
the same mobile phase present for Channel 1 A and B, use 50% A and 50%B. For a 1D+ system, 
use 100%A. 
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Figure 5-10.  LC Method Editor — Flow Table Tab 

step 10 Select the Flow Profile tab to present the Flow Profile dialog box (Figure 5-8). 

 

Figure 5-11.  LC Method Editor — Flow Profile Tab 
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step 11 The mobile phase composition can also be set by clicking and dragging points on the graph or by 

setting the % of A or B in the Profile Editor region. 

step 12 Once the method is complete, click Save to save the analysis method. 

5.6 Creating an LC Method- Channel 2 
step 1 Open the LC Method editor and type over the name of the method to create a new method.  Click 

Save. 

step 2 If you wish, enter any column information appropriate for your experiment. This information is 
information-al and stored with the LC method file. 

step 3 Click on the Run Conditions tab of the LC Method Editor window to obtain the Run Conditions tab 
(Figure 5-12). 

 

Figure 5-12.  LC Method Editor — Run Conditions Tab 

step 4 Put a check mark in the Pre-Run Flush column check box and specify a time of 0 minutes to flush 
the column using 100% of the initial flow rate conditions. 

step 5 Select Standard: in the Sample Injection region. This will cause the 10-port valve to be placed in 
the inject position for the duration of the Channel 2 run.   

step 6 Leave the check mark box for Post-Run Flush column empty.  

step 7 Click on the Flow Table tab to set the gradient parameters.  

step 8 Enter the gradient parameters you wish to run. Add new steps by clicking on the >> to the left of the 
table.  Delete steps by clicking on the X.  Set the overall flow rate on the right side. 
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Figure 5-13. LC Method Editor —  Flow Table Tab 

step 9 Select the Flow Profile tab to present the Flow Profile dialog box (Figure 5-8) 

 

Figure 5-14.  LC Method Editor — Flow Profile Tab 
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step 10 Use the flow profile tab to survey the gradient you created to make sure it is correct. The mobile 

phase composition can also be set by clicking and dragging points on the graph or by setting the % 
of A or B in the Profile Editor region. 

step 11 Once the method is complete, click Save to save the analysis method.  Click OK to close the editor. 

5.7 Creating the Run Table 
The Run Table ties together an autosampler and one or more LC method with a sample vial and tray 
position. You can also enter descriptive information related to the sample or analysis. This section will 
create a Run Table to run two samples with a trap and elute method. 

step 1 If not already in the Run Manager, click the Run Manager button located on the Eksigent Control 
Software’s Acquisition Window. (Figure 5-1). 

step 2 Create a new, blank Run Table by selecting Edit > Erase Table (Figure 5-15). 

 

Figure 5-15.  Creating a New Run Table 

step 3 Select File > Save As… and type trap loading in the File name field.  

step 4 Click Save. 

step 5 In the first line in the Run Table double click on the Autosampler Method field and select the 
autosampler method micropickup_1uL_trap loading from the drop down menu.  

step 6 Next, enter 1 for the tray and A1 for the sample Vial location. Alternatively, vial location can be 
entered by clicking at the vial on the picture of the vial tray in the Run Manager window. 

step 7 Double click on the LC Method field and select CH1 Trap Loading.   Indicate Channel 1 under the 
Channel column. 

step 8 In line 2, leave the autosampler method, tray and vial location blank.  Double click on the LC Method 
field and choose CH2 gradient.  Indicate Channel 2 under the channel column. 

step 9 For each sample you wish to run, duplicate these two lines in succession.  In Figure 5-16, two 
sample injections are indicated. 
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Figure 5-16.  Run Manager Window — Two Samples 

step 10 Check all the lines you wish to run under the Run column.   

step 11 Run the sequence in Sequential mode.  Click Flush/Equilibrate when Idle to start all the pumps if you 
wish.  Note:  If you need to edit the first two lines, un-check flush/equilibrate to do so. 

step 12 Now that the run table has been defined (Figure 5-16), save it by selecting File > Save. 

5.8 Starting a Run 
Samples to be analyzed are selected by placing a check mark in the box to the right of the appropriate 
row numbers in the Run Table. For this series of runs make sure there are check marks in the boxes for 
the first four rows of the Test Table created in the previous section. 

Checking the Flush/Equilibrate when Idle will initiate the pre-run flush for the first method. With this 
options selected, the system will continue to flush at the end of the sequence. 

Initiate the sequence of analyses by clicking on Start. After the start button has been pressed, it will 
change to a red ‘Stop’ button that can be used to abort the run at any point during the analysis. 

Once the flow rate has stabilized, the sample injection process will begin.  Channel 1 will run first, then 
Channel 2 will start at the conclusion of the Channel 1 run.   

While the run is in progress, the Acquisition Window can display the specified flow profiles for solvents 
A and B as well as their actual flow rates (Qa and Qb). Traces can be added or deleted from the 
display by clicking on System > Appearance in the Acquisition Window (Figure 5-1) and selecting the 
desired items. 

To zoom in on a particular area of the chromatogram, click on the display and drag a box around the 
area of interest. This will enlarge that area of the chromatogram. To zoom back out, right click and 
select Zoom Out or Back. 
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Figure 5-17.  Acquisition Window — Flow Profiles 

Status information such as %A, %B and Time Remaining are also displayed at the bottom of the 
screen during the run. Status bars at the top of the screen display the actual flow rate for pump A (Qa) 
and pump B (Qb) in nL/min, and pressure, in psi, for pump A (Pa), pump B (Pb) and column (Pc). 

5.9 Viewing the Collected Data Files 
Previously collected data files can be re-opened, reviewed and re-processed. 

step 1 To view the data file collected from the first chromatogram, click on File > Open… then select the 
data file. The nanoLC has an option to collect an external signal (e.g. a UV detector) through the A/D 
input on the 12-pin I/O connector. This data will be stored, along with the flow profile data, in the 
data file. The Control software also includes a data analysis package and this analysis can be applied 
to the collected A/D signal. See the software manual for further instructions on analyzing data files 
with the software. 

nanoLC Operator’s Manual 611-00012 Revision A1 





 

Chapter 6.  
Diagnostics and Troubleshooting 

Chapter 6 describes the built-in diagnostic capabilities of the nanoLC system along with the most 
common troubleshooting procedures. Topics covered in this chapter include: 

 overview of hardware diagnostics (Section 6.1) 

 calibration values (Section 6.3) 

 general troubleshooting guidelines (Section 6.4) 

 troubleshooting checklist (Section 6.5) 

 error messages and system alerts (Section 6.6) 

6.1 Overview of Hardware Diagnostics 
The nanoLC system includes a number of diagnostic capabilities designed to maintain peak system 
performance. The status bars and the text displayed in the Control software acquisition window provide 
general diagnostic capability for routine operation. It is a good practice to keep track of Pc pressure 
readings for the desired chromatographic method. Running the Hardware diagnostics is part of routine 
instrument maintenance and should be performed in the following schedule: 

 Every Month: Re-initialize pressure transducers 

 Every three months: Autotune the controllers 

 Every three months: Calibrate the flow meters 

Refer to section 4.5, 4.7 and 4.8 for details on running these diagnostics. 
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6.2 Calibration Values 
The Calibration Values tab of the Hardware Diagnostics Window summarizes the current K values of 
the flow meter, the gain and zero offsets of pressure transducers and the PID parameters for the 
pumps. The following settings are typical for a nanoLC and are shown for example only. The window on 
the left is for channel 1 and the window on the right is for channel 2, 

 

Figure 6-1.  Hardware Diagnostics — Calibration Values Tab 

The values should be documented before and after as part of maintaining a good instrument log, and 
noting changes.  These values should be very similar from diagnostic to diagnostic; large changes can 
indicate a problem. 
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6.3 General Troubleshooting Guidelines 

 

To avoid the possibility of electric shock, never disconnect an electrical assembly while power is 
applied to the system. After turning power off, wait about ten seconds before disconnecting an 
assembly. 

 

 

To prevent injury, always observe good laboratory practices when you handle solvents, change 
tubing, or operate the system. Know the physical and chemical properties of the solvents. Refer to 
the Material Safety Data Sheets for the solvents in use. 

 

 

There are no user serviceable components or assemblies inside the nanoLC. Service or any 
internal parts or assemblies requires a Factory Qualified Service Technician. 

When troubleshooting the nanoLC system, follow these safety practices: 

The basic steps for nanoLC system troubleshooting are: 

step 1 Step back and look at the overall system. Is something obvious causing the problem? For example, is 
an instrument unplugged or improperly connected? 

step 2 Compare current system operation with the way the system operated before the problem started. 
Identify conditions (pressures, power settings, flow rates) that are different than they were when the 
system was operating normally. 

For example, if the output pressure is usually 500 psi with a certain method, is the system pressure 
currently in the same range, or drastically higher (possibly caused by a plug) or lower (possibly 
caused by a leak)? 

step 3 Identify in the order listed below the symptom that varies from normal system operation: 

 System power on and initialization (initialization fails) 

 System diagnostics (flow stability, controller tuning) 

 Flow rate in each channel (high, low, erratic) 

 Output pressure (high, low, erratic) 

step 4 For each isolated symptom, identify a list of possible causes using the troubleshooting checklist be-
low. The troubleshooting in section 6.5 allows you to narrow down the possible causes of a symp-
tom and find suggested corrective actions. 

step 5 If this process does not correct the problem, contact Eksigent Technologies Technical Support. 
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6.4 Troubleshooting Checklist 

Table 6-1.  Troubleshooting Checklist 

Symptom Possible Cause Corrective Action 

System Initialization…   

Power LED on front panel is not 
on. 

 

Power cord not connected  

No power at outlet 

Power LED has failed but system 
response OK 

Connect power cord. 

Repair electrical outlet. 

Contact Eksigent Technologies 
Technical Support for assistance. 

 

Front panel power LED is on but 
software fails to recognize the 
instrument’s presence. 

Communication error between 
computer and an LC system 

Verify that the instrument’s serial cable 
is securely connected to the com-
puter’s COM1 serial port. (see Section 
2.5) Reboot computer and cycle power 
on instrument. 

Contact Eksigent Technologies 
Technical Support for assistance. 

 

Liquid leaking at the bottom of the 
mobile phase reservoirs 

The reservoirs were not placed in 
the pump adapter properly 

Verify the stopcock is placed properly 
and tightly screwed in. 

 

Loud hissing sound from the 
instrument 

Air leaks from the air inlet fitting Verify the air tubing is connected 
properly to the gas fitting. 

Tighten the air inlet gas fitting. 

Contact Eksigent Technologies 
Technical Support for assistance. 
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Table 6-1.  (cont.) Troubleshooting Checklist 

Symptom Possible Cause Corrective Action 

Flow Control System…   

System pressure (Pc) and/or 
pump pressures (Pa & Pb) show 
pressure even though the flow is 
off 

 

Pressure transducers zero offsets 
are incorrect 

Zero pressure transducers (Section 
4.5) 

No liquid out of waste line when 
purging 

Air trap in the pump 

Internal filters are plugged 
 

Leak in the system prior to the 
purge valve 

 

Prime the pump (Section 3.2). 

Contact Eksigent Technologies 
Technical Support for assistance. 

Check all connections. 

Pump restrokes frequently- Pump 
has reached end of stroke error 
message occurs 

Air trapped in the pump 

Pump remains on long enough to 
prompt a re-stroke 

 

Check valve is leaking 

Prime the pump (Section 3.2). 

Check the duration of time between re-
strokes to see if the pump re-stroke 
was appropriate. 

Contact Eksigent Technologies 
Technical support for assistance. 

Pump does not restroke at the end 
of a run 

Pump restroke delay is too short Contact Eksigent Technologies 
Technical Support for assistance. 

 

Pump flushes out quickly but does 
not deliver ~600 µL per stroke. 

Leak in instrument Contact Eksigent Technologies 
Technical Support for assistance. 

 

Purge output drips out slowly Internal filters are plugged Contact Eksigent Technologies 
Technical Support for assistance. 

 

No flow rate with 100% power 
indicated. System pressure (Pc) 
and pump pressures (Pa & Pb) 
are all low 

No air to system 
 

System not properly primed and 
flushed 

 

Connect 100 psi clean, dry air to the 
instrument’s air inlet. 

Prime and flush system (Section 3.2). 

Inability to reach desired flow rate Internal filters are plugged 
 
 

Flow rate set point too high for 
system back pressure 

Air pressure too low 

Contact local Eksigent Technologies 
Technical Support to replace internal 
filters. 

Reset flow rate to a lower level. 
 

Establish correct air pressure (100 psi). 
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Table 6-1.  (cont.) Troubleshooting Checklist 

Symptom Possible Cause Corrective Action 

Flow rate will not initialize at start 
of run 

Flow rate set point too high for 
system back pressure 

Erratic flow rate due to bubbles in 
system 

Unable to meet required flow rate 
within specified tolerance 

 

 

 

 

 

 

 

One or both of the Internal solvent 
filters may be plugged 

 

Reset flow rate to a lower level. 
 

Prime and flush system (Section 3.2). 
 

Relax flow tolerance setting (section 
3.2). 

Run the flow stability diagnostic to 
verify flow control (Section 4.6) 

Autotune flow controllers. [System > 
Hardware Diagnostics > Auto Tune 
Controllers] (Section 4.7) 

Flush system if flow is unstable 
(Section 3.2). 

If flow is still unstable, calibrate flow-
meters (Section 4.8) 

Contact Eksigent Technologies 
Technical Support for assistance. 

Flow rate will not stabilize during a 
run 

Erratic flow rate due to bubbles in 
system 

Incorrect mobile phase setting 
 

Pump controller is out of tune  

Flow temperature is not stable 

Prime and flush system (Section 3.2). 
 

Check the Mobile Phases setting 
(Section 3.2). 

Autotune flow controllers (Section 4.7). 

Contact Eksigent Technologies 
Technical Support for assistance. 

 

System responds sluggishly when 
changing flow rates 

Incorrect mobile phase setting 
 

Pump controller is out of tune Flow 
temperature is not stable 

Check the Mobile Phases setting 
(section 3.2). 

Autotune flow controllers. [System > 
Hardware Diagnostics > Auto Tune 
Controllers] (see section 4.7) 

 

Inaccurate flow rate with no 
signs of leakage 

Incorrect mobile phase setting 
 
Incorrect k-values 

Check the Mobile Phases setting 
(section 3.2). 

Perform flow meter calibration. [System 
> Hardware Diagnostics > Calibrate 
Flow meter] (see Section 4.8) 

 

System pressure (Pc) is unusually 
low but flow rate is OK 

 

Loose connection after mixing tee Check all connections for leaks. 

System pressure (Pc) is low and 
the flow rate is OK but pump 
pressures (Pa & Pb) are high 

Incorrect k-values 
 
 

Flow module is plugged 

Perform flow meter calibration. [System 
> Hardware Diagnostics > Calibrate 
Flow meter] (Section 4.8) 

Contact Eksigent Technologies 
Technical Support for assistance. 
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Table 6-1.  (cont.) Troubleshooting Checklist 

Symptom Possible Cause Corrective Action 

Excess flow noises Trapped air in the pump 

Pump controller is out of tune 

Prime the pump (Section 3.2). 

Autotune flow controllers. [System > 
Hardware Diagnostics > Auto Tune 
Controllers] (Section 4.7) 

 

Measured flow does not follow the 
flow profile 

Pump controller is out of tune 
 
 

Pump time response is set 
incorrectly 

Autotune flow controllers. [System > 
Hardware Diagnostics > Auto Tune 
Controllers] (Section 4.7) 

Adjust the pump time response in 
Hardware Diagnostics. 

 

Pa and Pb maximized to < 5300 
psi with 100% pump power. 

Incorrect gain setting for pressure 
 
 
 

Incorrect zero setting for pressure 
sensors  

Inline Air pressure too low 

Check the setting in Calibration Values 
Window in Hardware Diagnostic menu 
(1200 for 6000 psi transducers, see 
Section 6.3). 

Check the setting in Service menu 
(should be 500±200, see Section 6.3). 

Check the air pressure (~100 psi). 
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Table 6-1.  (cont.) Troubleshooting Checklist 

Symptom Possible Cause Corrective Action 

Autosampler…   

Software does not recognize nano 
LC Autosampler when Run 
Manager is started  

Communication error between 
computer and nano LC 
Autosampler 
 

Software may be configured to use 
a different COM port 
 

nano LC Autosampler is not in 
serial mode 

Verify that the RS-232 cable is securely 
connected to the S2 In port on nano 
LC Autosampler (see Section 2.6). 
 

Verify that the software is configured for 
nano LC Autosampler to connect to the 
correct COM port (see Section 2.6). 

Using the front panel of nano LC 
Autosampler, set it to serial mode. 
[Menu > Serial] (see Section 2.6). 

 

nano LC Autosampler does not 
trigger instrument to start a run 

Output cable is not connected 
properly 
 

Loose wire connection at the 
instrument I/O plug 

Verify the output cable is connected to 
P1 connector at the back of nano LC 
Autosampler. 

Make sure the wire ends are securely 
screwed in the I/O plug. 

 

Software does not trigger nano LC 
Autosampler to switch valve 
position 

Input cable is not connected 
properly 
 

Loose wire connection at the 
instrument I/O plug 

Verify the input cable is connected to 
P6 connector at the back of nano LC 
Autosampler 

Make sure the wire ends are securely 
screwed in the I/O plug. 

 

Injection Valve…   

Injection valve does not switch 
positions 

Valve is not connected to the 
actuator 

Valve is connected to the wrong 
channel 

Valve is not configured in nanoLC 
software 

Faulty actuator (LED is not on) 

Connect the cable from valve to 
actuator at the back of the instrument. 

Check and reconnect cable from 
actuator to the correct channel 

In Instrument Configuration, set 
injection valve as internal (Section 2.9). 

Replace actuator. 

 

No flow coming out from the port The valve is plumbed incorrectly 
 

The ports are plugged 

Verify the plumbing configuration and 
reconnect if needed (see Appendix C). 

Manually flush each port with cleaning 
solvent using a syringe. If flushing does 
not clean the port, contact Eksigent 
Technologies Service Representative to 
replace the valve. 
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Table 6-1.  (cont.) Troubleshooting Checklist 

Symptom Possible Cause Corrective Action 

System pressure (Pc) with no 
column connected is unusually 
high 

The ports are plugged 
 
 
 
 

The ends of fused silica connected 
to the port might be crushed or not 
cut properly 

 

Manually flush each port with cleaning 
solvent using a syringe. If flushing does 
not clean the port, contact Eksigent 
Technologies Service Representative to 
replace the valve. 

Check the ends under a microscope. 
Cut the ends if needed. 

Fluid leaking from the valve Ferrule was not seated properly in 
the port 

Rotor seal is scratched 

Check the tubing connection and make 
sure the ferrule is seated properly. 

Contact Eksigent Technologies 
Technical Support for assistance. 

 

Inconsistent flow rate Internal leakage in the valve 
 

Valve tubing connections are not 
made correctly (gap/dead volume 
between sleeves and port) 

The ports are plugged 

 

Contact Eksigent Technologies 
Technical Support for assistance 

Check tubing connections. Make sure 
the cuts at the end of the capillaries are 
square. 

Manually flush each port with cleaning 
solvent using a syringe, or contact your 
Eksigent Technologies Service 
Representative to replace the valve. 

 

Bubbles in the flow stream Bubbles trapped in the valve 
 

Valve tubing connections are not 
made correctly (gap/dead volume 
between sleeves and port) 

 

Attach a high restrictor at the port to 
flush out the trapped air bubbles. 

Check tubing connection. 

System does not initiate an 
injection 

 

System flow is unstable 
 

Flow stabilization is set too low 
 
 
 

Autosampler is configured with wait 
for injection but the LC method is 
used with no injection 

Purge both pumps and re-equilibrate 
system (Section 3.2). 

Set the Flow Stabilization Limit in 
instrument configuration to > 100 nL/ 
min. [System > Instrument 
Configuration] (Section 2.9) 

Change LC method to with injection or 
change the AS method without wait for 
injection command (see Sections 5.3 
and 5.4). 
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6.5 Error Messages and System Alerts 
System alerts can be displayed by selecting View > System Logs > Alerts. These alerts (Figure 6-4) are 
reminders of an action that needs to be taken; such as to run the diagnostic tests or refill the reagent 
storage loops. Pressing Clear Alerts will erase all alerts. Note: that this does not mean that the 
recommended alert action has been completed. 

 

Figure 6-4.  System Alerts Window 
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Appendix A  
Spare Parts and  Consumables 

A.1 Consumables: nanoLC-1D+ and nanoLC-2D  
part number description 

800-00006 Accessories kit for 1D. Includes calibration kit, syringe, fittings, capillary tubing and cables. 

801-00025 Accessories kit for 1Dplus and 2D. Includes mobile phase reservoirs, calibration kits, priming tool and syringe, 
fittings, capillary tubing and cables. 

801-00002 Flow rate calibration kit with 20 L calibrated pipettes (10) for 1 – 30 L/min flow rate 

801-00020 Replacement calibration pipettes, 20 L, for 1-30 L/min, 10/pkg 

801-00006 Flow rate calibration kit with 5 L calibration pipettes (5) for 50 – 1000 nL/min flow rate 

910-00007 Replacement calibration pipettes, 5 L, for 50 – 1000 nL/min, 10/pkg 

801-00003 Pump priming tool kit, includes 10 mL syringe (1D) 

910-00020 Fitting, FingerTight, 1/16”, PEEK, 10/pkg 

910-00021 Fitting, hex, 1/16”, SS, 0.43” long, 10/pkg 

920-00006 PEEK hex nut, 10/pkg 

910-00023 Ferrule, 1/16”, PEEK, 10/pkg 

910-00026 Ferrule, 1/16”, SS, 10/pkg 

920-00004 Fitting, hex, 1/16", SS, 3/4" long, 10/pkg 

920-00005 Fitting, hex, 1/16”, PEEK, ¾” long, 10/pkg 

920-00008 Sleeve, FEP, green, 395 m ID, 1/16" OD, 10/pkg 

200-00165 Fitting, NanoTight 1/16”, PEEK, 0.90” long, with Tefzel ferrule 

910-00022 Fitting, MicroTight, 0.025”, PEEK, 10/pkg 

920-00002 Ferrule, MicroTight, for 0.025", 10/pkg 

200-00002 MicroTight union, PEEK 

200-00044 Plug, MicroTight, PEEK, black 

920-00003 Nut, female, MicroTight, 10/pkg 

910-00043 Sleeve, PEEK, yellow, 180 m ID,  0.025" OD, 10/pkg 

910-00024 Sleeve, PEEK, orange,405 m ID, 1/16" OD, 10/pkg 

910-00025 Sleeve, PEEK, green, 395 m ID, 0.025" OD, 10/pkg 

200-00138 Mixing tee ferrule for 365 m OD capillary, 1/pkg 
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A.2 Replacement Parts: nanoLC-1D, nanoLC-1D+ and 
nanoLC-2D  

part number description 

200-00020 Internal pump filter element 

200-00032 Internal pump filter holder and element 

200-00047 Replacement rotor for 6 port PEAK injection valve (0.25 mm) 

200-00048 Replacement stator 6 port PEAK injection valve (0.25 mm) 

200-00058 Syringe adapter fill port, PEEK, NanoLC-1D injection valve 

200-00061 PEEK sample loop, 2 L 

200-00092 PEEK sample loop, 5 L 

200-00164 PEEK sample loop, 10 L 

200-00093 PEEK sample loop, 20 L 

200-00063 PEEK sample loop, 50 L 

200-00074 Syringe adapter fill port, SS, NanoLC-2D injection valves 

200-00083 10-port valve, titanium stator 

200-00130 Replacement stator for Titanium 10-port valve 

200-00212 Replacement stator for PAEK 10-port valve 

200-00131 Replacement stator for Titanium 6-port valve 

200-00159 Replacement rotor for Titanium 10-port valve 

200-00211 Replacement rotor for PAEK 10-port valve 

200-00160 Replacement rotor for Titanium 6-port valve 

200-00167 Front panel mixing tee with fittings and ferrules 

300-00000 Solvent waste/seal wash bottle, 250 mL 

 
400-00104 Power supply, input 100 – 240VAC /3A, output 24VDC /4A, NanoLC-1D plus & NanoLC-2D 

620-00060 Power cable, North America 

400-00078 Power cable, European 

920-00020 1.25 A fuses 5/pkg 

800-00020 Flow meter module, standard for NanoLC-1D 

800-00223 Flow meter module 1Dplus channel 2, 1-20 L/min 

800-00054 Flow meter module, standard for NanoLC-2D channel 1A & 1B 

800-00055 Flow meter module, standard for NanoLC-2D channel 2A & 2B 

800-00076 Flow meter module, standard for NanoLC-1D+ channel 2A & 2B 

800-00077 Flow meter module, standard for NanoLC-1D+ channel 1A & 1B 

910-00066 Replacement capillaries kit 1D Plus. Includes all SS/fused silica capillaries used in a 1D Plus, with fittings. 

910-00067 Replacement capillaries kit 2D. Includes all SS and fused silica capillaries used in a 2D, with necessary fittings. 

910-00063 Replacement capillaries kit 1D Plus. Includes all SS capillaries used in a 1D Plus, with necessary fittings. 

910-00064 Replacement capillaries kit 2D. Includes all SS capillaries used in a 2D, with necessary fittings. 

800-00058 Waste reservoir clamp and thumbscrew 

800-00105 Solvent reservoir, 50mL, clear 
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800-00141 Solvent reservoir, 50 mL, amber 

800-00194 Solvent reservoir, 100 mL, clear 

800-00200 Connector, 12-pin electrical, I/O, green 

 
400-00196 Connector, 4-pin electrical, switching valve, green 

400-00106 Serial cable for instrument control and data collection 

800-00056 External control synchronization cable 

910-00001 Line, air supply, 25', 1/4" 

300-00007 Internal air line, black, polyethylene, 18" 

100-00041 Fitting, air supply, 1/4" compression 

920-00088 Luer-lock fitting for mobile phase valve (set of 2) (1D) 

A.3 Replacement Parts: AS-1 Autosampler 
part number description 

801-00044 PM kit for AS-1 with Titanium valve. Includes pre-puncturing needle,  fused silica needle, 25 µL syringe and rotor 

801-00045 PM kit for AS-1 with PAEK valve. Includes pre-puncturing needle,  fused silica needle, 25 µL syringe and rotor 

620-00005 Wash bottle bracket  

620-00021 Air/pre-puncturing needle 

800-00044 Fused silica needle 2.4 µL Bio 

620-00139 PEEKsil needle 2.5 µL 

 
800-00045 Fused silica needle 5.4 µL Bio 

620-00027 Wash solvent vial with cap & screws 

200-00208 PEEKSil sample loop, 1 L 

620-00039 PEEKSil sample loop, 10 L 

620-00052 Belt 25.0 x 1.2 

620-00053 Syringe valve #5-4 & #5  

 
620-00059 Power cable Europe 

620-00060 Power cable USA 

620-00064 Syringe 25 L 

620-00140 Teflon seal between syringe and syringe valve  

910-00045 Replacement tip for 25 µL syringe, 5/pkg 

620-00065 Syringe 100 L 

620-00072 48 vial adapter 

800-00059 NanoLC-AS1 P6 input cable 

800-00060 NanoLC-AS1 P1 output cable 

800-00063 Buffer tubing, 500 L 

800-00064 Buffer tubing, 50 L 
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Appendix B  
External Interface 

B.1 Interface Connections 
Appendix B describes the external interface to other instrumentation in order to synchronize sample 
injection with data collection. The connector pin assignments are described below. The connector is 
located on the rear panel of the nanoLC. 

 

Figure B-1.  Rear Panel — External Interface and Valve Connectors 
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B.1.1 Remote Interface 
An enlarged drawing of the External Interface Connector shows that 12 lines are available (Figure B-2). 
These will be described in turn. 

A/D in The A/D in is a 24-bit A/D input for collecting the signal from an external detector using 
the nanoLC’s data system. 

GND GND is a system ground connection used in combination with other contacts such as 
RUN out. 

Run out The RUN out contact is used to trigger an external device at the time the gradient is 
started. Its polarity is configurable from within the Control software. The logic state 
changes at the be-ginning of the gradient (end of injection when using metered injection 
mode) and stays in on-state during gradient. 

PRK out The PRK out contact changes state when the peak parking function is actuated. Its 
polarity is configurable from within the Control software. 

RDY out The RDY out contact changes state when the pump is ready to start run (e.g.  at end of 
prerun flush). Its polarity is configurable from within the Control software. 

VLV out The VLV out contact goes to 0V (closes) when the injection valve moves from the Load 
position to the Inject position. Its polarity is NOT software configurable. 

ABS out The ABS out contact outputs an analog signal corresponding to the nanoLC’s detector 
absorbance. The wavelength monitored and the voltage- per-absorbance unit is 
configurable from within the Control software. 

RUN in The RUN in contacts allows remote starting of a method. Its polarity is configurable from 
within the Control software. The external trigger should be a pulse-type and does not need 
to be held in the trigger state. 

PRK in The PRK in contact allows remote triggering of the peak parking function. The instrument 
will re-main in the peak parking state until the contact’s state is changed. Its input polarity 
is configurable from within the Control software. 

 

 

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 

Figure B-2.  External Interface Connector 

AUX in The first AUX in contact is included for future expansion but is not currently used. AUX in 
The second AUX in contact is also included for future expansion. 

GND The GND contact is a system ground connection used in combination with other contacts 
such as ABS out. 
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B.2 Valve Connectors 

B.2.1 Remote Interface 
The rear panel also features a Valve connector used as an electrical interface between the nanoLC and 
various valves (Figure B-3). 

24 V  The 24V contact supplies the 24V power for the valve actuator. 

 

 

Figure B-3.  External Valve Connector 

GND The GND contact is a system ground for the valve connection. It is shared between the 
power sup-ply for the valve actuator and the trigger lines. 

VLV1 The VLV1 contact is the trigger line to move the valve to position 1 (the LOAD position by 
default). It is held low (0 V) momentarily to trigger valve  actuation to this position. 

VLV2 The VLV2 contact is the trigger line to move the valve to position 2 (the INJECT position 
by de-fault). It is held low (0 V) momentarily to trigger valve actuation to this position. 

B.3 Connecting to Other Instruments 
Other Autosamplers The active state (TTL low = 0 V or TTL high = 5 V) can be set for most I/O 
connections in the Instrument Configuration menu. It is important that the ground lead of the peripheral 
be connected to the ground connection on the nano LC. In addition, use of the nanoLC Autosampler 
provides a number of additional I/O signals with additional programming flexibility. 

 
Note: For all of the methods provided with the nanoLC and nanoLC Autosampler, and for all of the 
configurations discussed in this document, it is assumed that all of the inputs and outputs are 
configured as contact closures that are active in the closed state. 
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B.3.1 Other Autosamplers 
The nanoLC can be integrated with autosamplers from other vendors through the use of contact 
closures. A variety of configurations are possible using the inputs and outputs of the nanoLC described 
above. One suggested configuration is described here. 

Setup up the injection method and sample sequence using the autosampler interface (front panel or 
other software). Setup a matching sequence of chromatographic methods in the Run Manager of the 
nanoLC. Also make sure that LC Wait for Contact Closure is checked under the System menu in the 
Run Manager Window. Make sure that the analysis time per sample (time between autosampler 
injections) in the autosampler method is long enough to allow for the nanoLC method run time plus any 
pre-run flush equilibration for the next run. 

Connect the inject marker out from the autosampler to the Run Input (pin 8) and Ground (pin 7) of the 
nanoLC. Start the sequence by starting the Run Manager sequence and then the autosampler. After the 
autosampler initiates its own sequence for dispensing sample it will trigger the nanoLC to start its 
chromatographic run. 

The nanoLC also provides a Ready Out (pin 5) which can be used as an input to other autosamplers to 
synchronize runs and error check operation. 

 
Note: The optimized injection routines that can be utilized with the nanoLC Autosampler will, in 
general, not be available with other autosamplers. While the rapid inject or metered injection routines 
of the nanoLC method can be used to increase the flow rate during sample loading, one will not be 
able to switch the sample loop out of the flow path during the gradient. The may lead to significantly 
increased gradient delay times and decreased response times of the system. 

B.3.2 Triggering MS Data Collection 
While integrated control of the nanoLC system through the Xcalibur and Analyst software packages will 
be available, most MS systems will allow synchronization of data collection through the use of contact 
closures. The following describes the general configuration for this synchronization. 

In the MS software package, choose the option to start data collection with an external contact closure. 
This can be applied for a single MS run or to a sequence or batch of data collection methods. When 
conducting multiple runs in a sequence table, please configure the Run Manager of the nanoLC 
software with the corresponding sequence of methods. 

Set the Run Output configuration to contact closure (box checked) in the nanoLC soft-ware (menu). 

One must then identify the hardware interface for the MS contact closure input. This is typically either a 
terminal block mounted on the side of the MS instrument, or a pair of wires in an interface cable 
supplied with the MS. 

To synchronize MS data with the beginning of the gradient (after the injection), connect the Run Out 
(pin 3) and the Ground terminals to the MS contact closure. If one lead of the MS trigger is ground, 
make sure to connect it to the Ground connection of the nanoLC. For most applications, this 
connection will be made to the channel 2 (low flow gradient) side of the instrument. 

One can also choose to synchronize MS data with the beginning of the injection. To do this, connect 
the Valve Out (pin 6) and the Ground terminals to the MS contact closure. 
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B.3.3 Triggering Peak Parking 
Peak parking on the nanoLC system can also be triggered externally using the back panel I/O 
connectors. Connect the ground of the triggering contact closure to a Ground terminal on the back 
panel and connect the second wire of the contact closure to the Park In terminal (pin 9). The Park Out 
terminal (pin 4) can also be used to monitor the state of Peak Parking. The Peak Parking Toolbox in 
the nanoLC software is used to configure the Peak Parking flow rate, flow rate reference (typically 
‘column’), and provide for hold and lockout times on triggering. 

Peak Parking can be configured on ThermoFinnigan MS systems that provide a configurable con-tact 
closure output. This variable contact closure can be configured in the Xcalibur software to be activated 
based on selected criteria including ion intensities and ion inclusion lists. A number of systems may also 
allow a fixed time or duration contact closure that can be configured in the MS software to trigger peak 
parking. These may be useful for well defined experiments that will benefit from peak parking at a known 
time (not MS-dependent signals). 

B.3.4 Ready Out  
When using the nanoLC Autosampler, one can also handshake with other components, such as a MS 
detector, using the Ready Out from that device. This will allow the LC queue to stop if the peripheral is 
not ready. To do this, connect the Ready Out from the peripheral to the In 3 and Gnd of the AS1 Input 
(P6) cable. Add the following line to the beginning of the AS1 method. 

‘Wait for Input 3-LOW’ 

 
Note: If the Ready Out from the peripheral is a TTL high trigger instead of TTL low or contact closure, 
change the line to 3-HIGH. 

The AS method will not proceed beyond the first line until it has received a ready signal. If you 
disconnect the peripheral, be sure to remove this line from the AS method or to short In 3 to ground. 
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Appendix C  
Valve Configuration Diagrams 

This Appendix will show several possible configurations for the nanoLC. These sketches can be used 
as guides when configuring the plumbing for your own instrument. 

Figure C-1 shows an automated 2D configuration with 2 parallel traps. The flow on the traps is 
unidirectional. 

 

Figure C-1.  2D Configuration with 2 Parallel Traps 
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Figure C-2 shows a rapid sample loading configuration with 2 parallel traps. The flow on the traps is 
unidirectional. 

 

Figure C-2.  Loading Configuration with 2 Parallel Traps 
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Figure C-3 shows a rapid sample loading configuration with 1 trap. The flow on the traps is 
unidirectional. 

 

Figure C-3.  Loading configuration with 1 trap — unidirectional 
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Figure C-4 shows a rapid sample loading configuration with 1 parallel trap. The flow on the traps is 
bidirectional. 

 

Figure C-4.  Loading configuration with 1 trap — bidirectional

 



 

Appendix D  
Quick Start Guides 

D.1 Quick Start guide: Direct to Column Injection 
 

Direct to column sample injection: Plumbing schematic 
 

From CH2 Pump Outlet 

Autosampler 6-port 
Valve 

Column 

MS Interface 

 
 

To start a run in Eksigent software, open the Run Manager: 
 

To start a sample run, click Run 
Manager. 
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Select: Autosampler method, Tray, Vial, LC Method and Channel 2. 
Click on Flush/Equilibrate when Idle to start equilibrating pumps at initial gradient 
conditions. 
 

Click Flush/Equilibrate 
to start equilibrating at 
initial gradient 
conditions 

Once system is 
ready, click Start 
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Default methods: Direct injection to column with Channel 2. 
 
Autosampler: 
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Default methods: Direct injection to column with Channel 2. 
Pump: Channel 2 
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D.2 Quick Start guide: Dual Trap Column Method 
 

 
 

2 

3 

5 
4 

6 
7 
8 

9
10 1

Trap 1

Trap 2

MS 
Interface 

Column 

From CH1 Pump 
Outlet 

From CH2 Pump 
Outlet 

Waste 

Autosampler 6-
port 

Valve 

To start a run in Eksigent software, open the Run Manager: 
 

To start a sample run, click Run 
Manager. 
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Run in Synchronized Multi-Channel mode. 
Sequence line 1: Load trap 2 
Line 2: Gradient Trap 1 
Line 3: Load trap 1 
Line 4: Gradient trap 2 
 

Click on Flush/Equilibrate when Idle to start equilibrating pumps at initial gradient 
conditions. 
 

Click Flush/Equilibrate 
to start equilibrating at 
initial gradient 
conditions 

Once system is 
ready, click Start 
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Default methods: Dual Trap column configuration 
 
Autosampler: 
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Default methods: Dual Trap Column Configuration: 
Pump: Channel 1 
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Default methods: Dual Trap Column Configuration: 
Pump: Channel 2, Trap 1 
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Default methods: Dual Trap Column Configuration: 
Pump: Channel 2, Trap 1 
Same as previous method- except injection = NONE instead of injection = Standard. 
 

  

 
 

Hints for Dual Trap columns: 
1. Channel 1 and 2 methods should run the same length of time. 
2. If pre-washing traps is desired, change Channel 1 sample injection type to 

NONE and use timed events: 
a. VLV TTL low starts the injection 
b. VLV TTL high ends the injection 

3. Contact Eksigent Technologies Support for guidance with complex HPLC 
methods. 

 
 

 



 

Appendix E  
Replacing Internal Instrument Filters 
Replace solvent filters and check for leaks 

step 1 Power off AS-1 autosampler and remove output, input, serial and power cables.  Disconnect 
tubing connections from the autosampler valve, and remove the waste tubing from the waste 
container.  Remove the autosampler from the top of the nanoLC and set aside. 

step 2 Power off the nanoLC. 

step 3 Open the cover of the nanoLC and visually check for any signs of leaks, corrosion, etc.  If any 
of the pumps appear to have leaked, follow the procedure to replace the pump seals found in 
Appendix A of this document. 

step 4 Remove the internal instrument filter assemblies with a 9/16” and ¼” wrench. 

step 5 Open the filter assemblies and remove the filter frits.  Rinse the filter assemblies with 
methanol and replace with new filter frits.  Tighten the filter frits in place finger tight + ¼ turn 
with two 7/16” wrenches. 

step 6 Re-install the filter assemblies and tighten the stainless steel tubing connections into the filter 
assemblies. 

step 7 Turn on the power to the nanoLC and establish communication. 

step 8 Purge out or remove the old solvent from the mobile phase reservoirs.  Refill with new solvent 
and purge at least 20 times on each pump. 

step 9 Disconnect any tubing at the outlet of Channel 1 and Channel 2. 

step 10 Flush 100uL through Channel 1 and Channel 2.   

step 11 Test the nanoLC for leaks:  

a. Plug the outlet of CH1 and CH2 
b. In the service menu, ramp the power in steps: 25%, 50%, 100%.  Check system for 

leaks in fittings inside the box. Repair any leaks, then ramp the power again to test. 
c. Hold the system at 100% power for 10 minutes.  Repair any leaks and then stop the 

flow. 
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